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Excel Tour

I n t h i s c h a p t e r y o u w i l l l e a r n :
• Excel’s capabilities and new features

• How to start, navigate, and work with Excel files

• How to use Excel help

• How Excel is used in accounting

Case: What SUP, Inc.

Nathan Peters and Meagan Lopez own What SUP, Inc., located in Seattle,
Washington. They’ve been in business for five years and have developed a
number of online customers. The fast-growing sport of stand up paddleboarding
(SUP) is a fun, easy way for their customers to go play on the water. With a
minimum of equipment, their customers can paddle anything from ocean surf to
lakes and rivers—no waves required. They are eager to expand their customer
base and their supplier pool. Their local C.P.A., Kyle Ski, has suggested hiring
a local college student to help them computerize their operations. He suggests
they use QuickBooks to keep their accounting records but also encourages them
to use a worksheet software application to help them analyze their business sit-
uation and support their accounting operations. Nathan, excited to get started,
places an ad in the local college paper.

As an accounting student at the local college, you’ve become fairly adept at
using computers to complete homework assignments but you’re eager to
broaden your horizons. You’d like to combine your accounting and computer
skills with some practical experience. Lucky for you, an ad in the college paper
for part-time computer and accounting help falls on your desk one afternoon.
After an intense interview and background check, you’re hired!

Your initial meeting with Nathan, Meagan, and Kyle reveals some unfami-
liarity with the software application Kyle has suggested you use. Kyle has
agreed to coach you through the basic use of the worksheet program after
Nathan and Meagan reluctantly agree to pay his fees. They’re hoping, of course,
that you can learn the worksheet application quickly and help them use it to fur-
ther their business expansion.

First off, Kyle introduces you to Excel, a powerful worksheet application he
has been using since the mid-eighties. Kyle explains that this most recent incar-
nation of Excel is far more than a simple calculation program.
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Understanding Excel’s Capabilities

You have often used paper worksheets in your accounting courses and ask Kyle
if Excel is just an electronic version of that same worksheet. He explains that,
in essence, you are correct. In your beginning accounting courses, a worksheet
might have been used to adjust a trial balance for accrual accounting and to cre-
ate financial statements like the income statement, balance sheet, and statement
of cash flows. You added columns of numbers, subtotaled them in places, drew
lines, created titles, and so forth.

Excel is, however, much more than an expensive calculator or place to put
information. Built-in functions can help an accountant create financial state-
ments, pivot table reports, analyses, depreciation schedules, loan amortization
schedules, cash flow budgets, cost-volume-profit analyses with charts, and
more. But first, you need to become familiar with the multitude of Excel com-
mands and procedures.

Starting, Navigating, and Working
with Excel Files

To begin, Kyle asks you if you are familiar with starting programs in Windows 7.
Since Nathan and Meagan admit to very little knowledge of computers, you offer
to demonstrate. First you explain that some of the company’s computers use the
Windows Vista, Windows 8, or XP operating system but that the one you are
most familiar with uses the Windows 7 operating system. In either case, you
explain that starting Excel is the same in either operating system. You then offer
to demonstrate the process for starting Excel in Windows 7.

To start Excel:

1 Click the Start button.

Video Demonstration

DEMO 1A Exploring
the Excel window
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Kyle explains that Excel always opens a list of recent worksheets and thumb-
nail pictures of built-in Excel templates. In this text, you’ll be building your
own worksheets or modify existing spreadsheets to solve accounting-related
problems. To begin you’ll often begin by double-clicking a blank worksheet.
Your window should look like Figure 1.2. A worksheet is a grid of rows and
columns into which you enter information. You can add additional sheets to a
workbook if necessary.

Nathan has been replicating Kyle’s actions on his own laptop, which has
Excel installed as well. He notes that his screen does not exactly match Kyle’s,
whose Quick Access toolbar and Ribbon seem different than Nathan’s. Kyle
explains that screen size can change the appearance of the Ribbon and that both
the Ribbon and Quick Access toolbar can be customized.

To illustrate, Kyle has captured his Excel window in Figure 1.2 and provided
callouts and an explanation of the Excel window characteristics.

2 Select All Programs and then scroll down your list of programs
and click the Microsoft Office folder. Your window may look like
Figure 1.1.

3 Click Microsoft Office Excel 2013 to start the application.

T r o u b l e ? Your start menu may be completely different from
that shown in Figure 1.1. See your instructor or lab personnel for
instructions on starting Excel.

Figure 1.1
Starting Excel

Excel Tour Chapter 1 5

Copyright 2014 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). Editorial review has 
deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.



File – This is where you manage your files and the data about them — creating,
saving, inspecting for hidden metadata or personal information, and setting
options. In short, it is everything that you do to a file that you don’t do in the file.

Quick Access Toolbar – At the top of the Excel window is the Quick Access
Toolbar, which is designed to give you an easy way to execute the commands
used most often. The default setting in Excel provides access to the Save, Undo,
and Redo commands. The Quick Access toolbar can be modified to include the
Print Preview, Open, Quick Print, and other commands as well. This is accom-
plished by right-clicking the Quick Access Toolbar and selecting Customize
Quick Access Toolbar (or by right-clicking any command on the Ribbon and
selecting Add to Quick Access Toolbar). Don’t adjust your Quick Access Tool-
bar yet; we’ll get to that shortly.

Ribbon – There are three basic components of the Ribbon, as follows.

1 Tabs: There are several of them across the top depending on whether you
have added any add-ins to Excel. Each represents core tasks you do in
Excel.

2 Groups: Each tab has groups that show related items together.

3 Commands: A command is a button, a box to enter information, or a
menu. The principal commands in Excel are gathered on the first and
second tabs, the File and Home tabs.

Vertical
Scroll Bar

Horizontal
Scroll Bar

Ribbon

View ToolbarSheet Tabs

TabsQuick Access Toolbar

Formulas

Groups

Commands

Help Button

File Tab

Figure 1.2
The Excel Window
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The commands on this tab are those that Microsoft has identified as the most
commonly used when people do basic tasks with worksheets. For example, the
Paste, Cut, and Copy commands are arranged first on the Home tab, in the
Clipboard group. Font formatting commands are next, in the Font group. Com-
mands to center text or align text to the left or right are in the Alignment group,
and commands to insert and delete cells, rows, columns, and worksheets are in
the Cells group. Groups pull together all the commands you’re likely to need
for a particular type of task, and throughout the task they remain on display and
readily available instead of being hidden within menus. These vital commands
are visible above your work space.

The commands on the Ribbon are the ones you use the most. Instead of
showing every command all the time, Excel 2013 shows some commands in
response to an action you take. When you see an arrow (called the Dialog Box
Launcher) in the lower right corner of a group, there are more options available
for the group. Click the arrow, and you’ll see a dialog box or a task pane.

Other Excel Window Items – As with all Windows screens, scroll bars control
your view of the worksheet (horizontal and vertical). Formulas contained in
each cell are displayed in the Formula Bar. The View Toolbar gives you quick
access to viewing your worksheet in Normal layout (shown in Figure 1.2), Page
layout (shown in Figure 1.5), or Page Break preview layout.

To demonstrate some of Excel’s features, Kyle suggests you
follow along while he opens an old Excel file:

1 Open Excel, if you closed it previously.

2 Click on the right of the Quick Access Toolbar and then place a check
next to the Open command. This will add the Open command to your
Quick Access Toolbar if it is not already there.

3 Click your newly created Open icon in the Quick Access Toolbar to
open a new file. (Note: if you are using Excel in a computer lab envi-
ronment, your changes to the Quick Access Toolbar may not reappear
the next time you start Excel.)

4 Navigate the Open window to the location of this text’s student files.
(The location would be the CD provided with the text or from your
computer lab’s server.)

5 Double-click the file ch1-01, which should be located in a Ch 01
folder. The workbook shown in Figure 1.3 should appear.

6 Click the File menu and then click Save As. (This is done to keep
your original student file available in case you need it again and also
to provide a unique name for your file.) Click Computer and then
click Browse to navigate yourself to the location where you want to
save your file.
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7 Add your name to the file name using the underscore key as shown in
Figure 1.4. In this example, the file will be saved as ch1-01_student_
name (replace student_name with your name). In this example, the file
was saved to a removable flash drive called G Owen (E:) in a folder
called Excel Files as seen in Figure 1.4. Your file location may be
different but it is recommended that if you are working in a lab
environment that you save your files to a removable disk or online
location.

8 Click Save.

9 Click in cell A1. This is now the active cell.

10 Hold the Shift key down and then click in cell F1. This should then
highlight cells A1:F1. Alternatively, you could click in cell A1 and,
with the mouse button down, drag the cursor to cell F1.

11 In the Font group, click the B icon to make the text in those cells
bold.

12 In the Alignment group, click the center text icon to center the text in
those cells.

13 Click in cell D2 and then with the mouse button down, drag the cursor
to cell D31.

14 In the Number group, click the $ icon to format the text in those cells
in currency format.

Figure 1.3
Sample Workbook
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Borders
button

Bold button Center button
Click here to launch the
Numbers group dialog box

Click here to view
SUM function in action

SUM function
formula for cell D31

Figure 1.5
Ch1-01 Student File as Modified

Figure 1.4
Saving a Worksheet
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Kyle further discusses and then illustrates the changes in Excel’s appearance
when a different view is selected and when the screen resolution or size is
changed.

Page Layout View – In Page Layout view, there are page margins at the top,
sides, and bottom of the worksheet as well as a bit of blue space between work-
sheets. Rulers at the top and side help you adjust margins. You can turn the rul-
ers on and off as you need them (click Ruler in the Show/Hide group on the
View tab). With this new view, you don’t need Print Preview to make adjust-
ments to your worksheet before you print. It’s easy to add headers and footers
in Page Layout view; when you type in the new header and footer area at the
top or bottom of a page, the Design tab opens with all the commands you need
to create them. You can see each sheet in a workbook in the view that works
best for that sheet. Just select, for each worksheet, a view on the View toolbar
or in the Workbook Views group on the View tab. Normal view and Page
Break preview are both there.

Screen Resolution and Window Size – The figures displayed so far should match
your version of Excel if your screen is set to high resolution and the Excel win-
dow is maximized. If not, things look different. If your screen is set to a low
resolution—for example, to 800 by 600 pixels—then a few groups on the Ribbon
will display the group name only, not the commands in the group. You will need
to click the arrow on the group button to display the commands. The groups that
display only the group name in a smaller resolution are those with less frequently
used commands. At any resolution, if you make the Excel window smaller, there
is a size at which some groups will display only the group names and so you will
need to click the arrow on the group button to display the commands.

To examine the affects of page layout view and screen size:

1 Scroll to the top of the worksheet so that row A is visible in your
ch1-01 file.

15 In the Number group, click the arrow next to the Number group name
to launch the Dialog Box Launcher.

16 Type 0 in the decimal places text box, and then click OK.

17 Use the vertical scroll bar to move down the worksheet until you can
see row 31.

18 Click in cell D31. Note the formula =SUM(D2:D29) which appears on
the formula bar.

19 In the Font group, click the Borders icon and then select the Top and
Double Bottom Border icon. Depending on the size of your Excel
window, your screen should look like Figure 1.5.

20 Keep this file open.
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2 Click the View tab and then select Page Layout from the Workbook
Views group. Alternatively, you could have selected the Page
Layout icon from the View Toolbar. Your screen should look like
Figure 1.6.

3 Click the Show group to see the expanded menu in Figure 1.7.

4 Uncheck the Ruler, Formula Bar, Guidelines, and Headlines check-
boxes to modify the look of the worksheet.

5 Click the Show group and then check the Ruler, Formula Bar, Guide-
lines, and Headlines checkboxes.

Margin
Rulers

Row
Headings

Column HeadingsView Tab SelectedPage Layout Selected Workbook Views Group

Figure 1.6
Page Layout View of the Excel Window

Figure 1.7
Show/Hide Group on the
View Tab

Excel Tour Chapter 1 11

Copyright 2014 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). Editorial review has 
deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.



6 Click in the text Click to add header and then click in the left header
box.

7 Type September Sales as the new header.

8 Select the September Sales text, click the Home tab, and click the B
(Bold) button. Your screen should look like Figure 1.8.

9 With the text still selected, select 12 in the font size text box.

10 Click A (to select column A) and then click the center text button in
the Alignment group twice.

11 Click F (to select column F) and then click the center text button in
the Alignment group twice. Your modified screen should look like
Figure 1.9.

Figure 1.8
Modified View of the Sales

Data Worksheet
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‘‘What are the tabs at the bottom of the worksheet?’’ Meagan asks.
‘‘Those are different worksheets contained in our workbook’’ Kyle explains.

‘‘I create those using Excel’s Pivot Table feature, which I’ll explain later. For
now I’ll have you look at them to see what they tell us.’’

Kyle then explains that the Pivot Table feature in Excel allows you to view
data in multiple ways. In the Sales by Salesperson worksheet, he organized the
sales data (located on the sales data worksheet) by salesperson, providing a total
of the month’s sales by individual salesperson. In the Sales by Customer work-
sheet, he reorganized the sales data by customer, providing a total of the month’s
sales by individual customer. In both cases, Kyle has used Excel’s new condi-
tional formatting feature to reflect graphically the values for salespersons and cus-
tomers relative to each other. These tools will be demonstrated in later chapters.

To view additional worksheets in a workbook:

1 Click the Sales by Salesperson tab to reveal the worksheet shown in
Figure 1.10.

12 Keep this file open.

Click here to
make text bold

Click here to
center text 

Click here to
select column F

Click here to enter
header text 

Click here to open
other worksheets in
the workbook

Figure 1.9
Modified September Sales
Worksheet
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Now that you’ve had a brief view of how to start, navigate, and work with
Excel files, it’s time to become familiar with Excel’s help features.

2 Click in the down arrow next to the Row Labels text to view alternative
ways of sorting or organizing this information.

3 Click the Sales by Customer tab to reveal the worksheet shown in
Figure 1.11.

4 Again, click in the down arrow next to the Row Labels text to view al-
ternative ways of sorting or organizing this information.

5 Click on the Sales Data tab to re-open the Sales Data worksheet.

6 Keep this file open.

Figure 1.11
Sales by Customer

Worksheet

Figure 1.10
Sales by Salesperson

Worksheet
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Getting Excel Help

Excel’s help features are quite extensive. Anytime you are working with Excel
and are not certain how to accomplish a task—for example, format a cell, write
a formula, or create a chart—then you should press the [F1] function key or
click the blue and white question mark on the Tab bar. To illustrate, Kyle
decides to show you Excel’s help feature when trying to create a new chart.

To view Excel’s help to create charts:

1 Press the [F1] function key or click the question mark located in the
upper right-hand corner of your screen to open Excel’s help window as
shown in Figure 1.12.

T r o u b l e ? You do not have to be connected to the Internet to get
Excel help. However, the online help is much more extensive. This
example assumes you are connected to the Internet. If you are not con-
nected, Excel will give you access to Basic Help. As a result, none of
the following steps will work.

2 Type Creating Charts into the Search help text box and then press
[Enter].

3 Click Create a chart.

Figure 1.12
Excel’s Help Window
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Now that you’re familiar with Excel’s help feature, Kyle thinks it is a good
idea to explore how Excel is used in the accounting field.

Examples of How Excel Is Used in Accounting

There are an unlimited number of ways Excel can be used in accounting. This
text will focus on building worksheets by using formulas, functions, and fea-
tures available in Excel to create and analyze inventory and financial statements,
calculate depreciation and create depreciation schedules, create loan and bond
amortization schedules, and create cash flow budgets.

You may have previously learned how to create financial statements from a
trial balance. For example, the trial balance in Figure 1.14 contains data that,
through the use of cell references, formulas, and other Excel features, might be
used to create an income statement. However, in most cases, accounting pro-
grams like QuickBooks and Peachtree are used to gather and summarize infor-
mation to create financial statements. In this text, we will focus on how to use
Excel to support the creation and analysis of those statements. Another example
is the creation and maintenance of an inventory list. Figure 1.15 illustrates the
use of Excel to manage inventory items, which you’ll do in Chapter 2.

4 Read the Create a chart article as shown in Figure 1.13. Then close the
Excel Help window.

Figure 1.13
Excel Help for Creating a

Chart
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Figure 1.15
Inventory Listing

Figure 1.14
Trial Balance
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In Chapter 3, you’ll learn how to perform a financial statements analysis. For
example, income statements between 2014 and 2015 are compared via a horizon-
tal analysis in Figure 1.16, which includes a ‘‘percent of change’’ column. An
analysis of expenses for a given year is depicted in the pie graph of Figure 1.17.

In Chapter 4, you’ll learn how to perform depreciation calculations and create
a depreciation schedule. For example, you’ll use Excel’s SLN (Straight-line
depreciation function) to calculate the depreciation expense for each year and
related accumulated depreciation, as shown in Figure 1.18. You’ll also use
Excel’s DDB (Declining balance depreciation function) to calculate depreciation
expense for each year, as shown in Figure 1.19.

Figure 1.17
Expense Chart

Figure 1.16
Horizontal Income Statement
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In Chapter 5, you’ll learn how to perform loan amortization schedules and
calculate loan payments given an interest rate, term, and loan amount. For
example, you’ll use Excel’s PMT (Payment function) and formulas to produce
the loan amortization schedule shown in Figure 1.20.

In Chapter 6, you will learn how to prepare cash receipts budgets based on a
pattern of expected cash collections; see Figure 1.21 for an example.

Figure 1.19
Double Declining Balance
Depreciation

Figure 1.18
Straight-line
Depreciation
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Finally, in Chapter 7, you’ll learn how to use Excel to prepare a present
value analysis (Figure 1.22), predict future costs (Figure 1.23), and calculate an
allowance for uncollectible accounts (Figure 1.24).

Figure 1.20
Loan Amortization Schedule

Figure 1.21
Cash Receipts Budget
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Figure 1.23
Predicting Future Costs

Figure 1.22
Present Value Analysis
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End Note

The three of you are somewhat overwhelmed by your first exposure to Excel
but are pleased with what you’ve accomplished. You’ve learned some of
Excel’s capabilities and new features; how to start, navigate, and work with
Excel files; how to use Excel help; and how Excel is used in accounting.

In the next chapter, you will learn how to enter information, create formulas,
use functions, and print in Excel.

Figure 1.24
Calculating an Allowance for
Uncollectible Accounts
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Chapter 1 Questions

1 Identify some new features in the 2013 version of Excel.

2 Why would you use conditional formatting?

3 Explain the difference between a worksheet and a workbook.

4 Describe the nature of the commands found on the File and Home tabs.

5 What and where is the Quick Access Toolbar?

6 Describe the three basic components of the Ribbon.

7 How do you modify the Quick Access Toolbar to add the Open command?

8 What is the Page Layout view?

9 What is the quickest way to get help while in Excel?

10 What are the key accounting topics addressed in this text that relate to
your learning Excel?
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